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From The Editor
What you are looking at is the January 2017
edition of the MaUsE DoubleClick, the online 
publication of the Macintosh Users East, (MaUsE),
a motley collection of mostly harmless cranks who
reside in Southern Ontario with their motley 
collection of old and new Macintosh,Hackentosh &
MacClone computers.

The DoubleClick is published using a 2009 2.93
GHz  Quad-Core Intel Xeon Mac Pro tower and 
QuarkXPress 2016. An antique Kodak DX7590 is
STILL being used for all pictures. Everything not
specifically attributed to someone else can proba-
bly be blamed on the Editor. Back issues can be
downloaded from the MaUsE website at : 
< www.mause.ca >. Submissions from MaUsE
Club members are almost always welcome. Maybe
that last bit is an exaggeration.

Send your submissions and articles to me at: 
< ducati860@gmail.com >, especially if there are
files or pictures attached. I have never refused a
submission yet. Because we care about the envi-
ronment, the MaUsE DoubleClick is created using
only recycled electrons: matter was neither created
nor destroyed in the process of creating this issue.
There is always room for another piece on any
Mac-related topic and Iʼll make room if there isnʼt. I
would like your submissions. But I won't beg.

Apple, Macintosh, and the Apple logo are trade-
marks of Apple Inc.®, registered in the U.S. and
other countries. 
The MaUsE (Macintosh Users East) is an Apple
Inc.-authorised Apple User Group. 

Michael Shaw, Editor
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Michael Shaw 
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Please remember to
pay your MaUsE 
Membership fee: 

Still only 
$45 per year.

MaUsE Meetings are held in Room 1 at the new Whitby Public Library on the
corner of Henry and Dundas West in Whitby, Ontario on the fourth Wednesday of

each month except December, July & August, starting at 7:00 PM.

Facebook MaUsE 
https://www.facebook.com/Macintosh-Users-East-748334841881285/.
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AKVIS
Retoucher 8.1

AKVIS closed out 2016 with a bang, or half a dozen bangs to be
more accurate. There was a flurry of releases that included one new
program called Watercolor 1.0 that was mentioned and described in
last month’s issue of the DoubleClick, and major updates to a handful
of other AKVIS titles. In this month’s issue we will take a quick illus-
trated look at three of them, Retoucher, Multibrush, and Coloriage.
These programs can be bought separately or all at once in the AKVIS
Restoration Bundle with 40% discount. The programs run on Win-
dows XP, Vista, 7, 8, 8.1, 10; and Mac OS X 10.7-10.12. 

Updates are inevitable when a company has a couple of dozen
different programs and AKVIS is a company with 25 programs for dig-
ital photographers. All of the AKVIS programs are available for Mac
and Windows, can be used by professional and amateur photogra-
phers to enhance their images, are available as both a stand-alone
application and as plug-ins for Adobe Photoshop and Ps Elements
(all other popular image editing programs), and can be downloaded
from http://akvis.com/en/download-macintosh-software.php and used
as a fully featured DEMO without restriction for ten days without any
obligation to keep or pay.  The ten day “try before you buy” policy
means that you have plenty of time to explore the abilities of AKVIS
software and access the online tutorials, videos, examples and manu-
als in order to fully understand what you are buying before you pay
any money. Once you do decide to purchase the program, you will
find that there are several licenses available, all reasonably priced, at
levels that vary based on type of use (personal or commercial) and
type of installation. The price per program varies as well.

In the case of Retoucher 8.1 the cost and license structure are as
follows:
Home license for plug-in or stand-alone : US $87
The Home License is a license for non-commercial, personal use
only.  Commercial uses are strictly prohibited. Such version may not
include all features, it usually has less functionality than the superior
versions (Deluxe/Business), but enough to meet the needs of a home
user.  Home License allows registering and using the software on 2
computers.

Home Deluxe license for plug-in and stand-alone : US $98
The Home Deluxe license, like the Home license, can be used only
for non-commercial, personal purposes. It is an advanced version of
Home license; it is valid for both plugin and standalone editions. Apart
from the flexibility provided by this license type, its owners enjoy more
functionality. The license is targeted at advanced users who have
high requirements to the software. Home Deluxe License allows reg-
istering and using the software on 2 computers.

Business license for plug-in and stand-alone : $ $154
The Business License is a license for commercial institutions and in-
dividuals that derive a profit from usage of the Software. Commercial
use is allowed. The license is valid for both plugin and standalone
versions and offers full functionality. All features are included! The li-
cense is targeted at professionals.  Business License allows register-
ing and using the software on 2 computers.

As with the other AKVIS programs I have referenced and written
about, Retoucher 8.1 is a powerfully useful and entertaining piece of
software. The interface invites exploration and experimentation. It is
also one of the more expensive of the AKVIS programs because of its
wide range of uses and powerful image-improving features. if you
have ever spent (or wasted) hours in an effort to fix up old black and
white scanned photographs that were torn, scratched, folded or im-
mersed in water you will be able to appreciate Retoucher. AKVIS Re-
toucher not only removes dust, scratches, stains and other defects
that appear on damaged photos but is also able to reconstruct miss-
ing parts of a photo using the information of the surrounding areas.
The work is done automatically; you only have to indicate areas to be
restored, push the Run button, and here you are - the surface be-
comes smooth and imperfections disappear.  And for digital images
that are picture perfect except for one glaring detail, like a wire across
a scene or something nasty in the background, Retoucher can be in-
voked to quickly isolate and remove the offending feature or object,
and provide the cloning tools for replacing it with a fair approximation
of what might lie behind it. You could spend hours with Photoshop or
minutes with Retoucher.

You can use AKVIS Retoucher to:
 - Restore old and damaged photos from your family archive by re-

moving scratches, stains and other defects;
 - Improve the composition of your photos by removing the date

stamp, distracting details (wires, refuse bins, etc) and by extending
the photo canvas (increase the image canvas and the plug-in will
recreate the image patterns in the blank areas);
 - Reconstruct missing parts of the photo (to restore a torn photo,

in polygraphy to extend the borders of a layout that does not have
space for cropping).
 - Remove larger and complex objects (people, cars, buildings).

See some of Irma’s pictures on the next pages....







Time to Share Your Knowledge

Program Suggestions for future meetings
 Photos with Yosemite

 Google vs Wolfram Alpha 
 Services 

 How do Flash Drives work
 Sound on computer

 Consequences of Jailbreaking 
 Medical & Health apps

 Geocaching 
 Instagram / Facetime / Messaging

 Web site business ideas
iTunes - iTunes U, Podcasts, and Radio

 Apple TV   
 Apple Pay 

 Use for Notes
  Amazing Mac OS X tips 

 Tricks for the iPad
 Vintage Macs 

 Can my car or remote garage opener be hacked? 

We have, within the membership of our MaUsE Club, a
lot of members who do interesting things with their comput-
ers. We have a wide range of skill levels from new users
and beginners right up to genealogy experts and people
who edit video and audio files. Sometimes we have a hard
time coming up with interesting presentation topics and
meeting content that will amuse, educate and entertain peo-
ple who are new to computers and at the same time hold
the attention of people who who have been into computers
for 40 years or more.

Below is a partial list of topics that we think might be of
interest for presentations at future MaUsE meetings. If you
would like to add something to it, please send suggestions
to  michaelshaw@mause.ca. If you think you know enough
about any of the suggestions to make a presentation at a
future meeting, likewise, contact  michaelshaw@mause.ca.
And if you would like to have 10 or 15 minutes or more a
one of our meetings to let us know what exciting things you
are doing with your Mac computer or iDevice, please feel
free to contact  michaelshaw@mause.ca.



Take Control eBooks
Take Control of Your Passwords 

DoubleClick features an ebook from Take Control Books every
month. These ebooks have been published in PDF format and cover
issues related to Mac OS. Because they are in PDF format, these
ebooks have a lot of advantages over the traditional paper books.
Electronic books are a new experience for many people, but they pro-
vide you with a good deal of flexibility that isn't available with printed
books. With your purchase of the ebook you get expert advice on var-
ious topics but with an Apple perspective. These are the same expert
authors of some best-selling print books. The download is immediate
and you don't have to leave your house to get it. Because it is paper-
less it can be purchased for much less than a paper edition. Also, if a
new edition of the book comes out, your original purchase of the book
allows you to easily update your current copy for free. There are click-
able links right in the text so that your book immediately leads to
other sources on the same topic. It is readable onscreen which
means you can control the size of the print. If you use Preview you
can even highlight sections without messing up the book (use a copy
of the original if you are worried). You can even print up a paper copy
of the book if you feel the need. The catalog is very extensive and
can be accessed from http://www.takecontrolbooks.com/catalog.
They offer free sample sections of all their ebooks and a money-back
guarantee, so try one out anytime. As readers of the DoubleClick, you
also now have access to this coupon (CPN90219MUG) which entitles
you to a 30% discount on the purchase of a book.

The book featured this month is Take Control of Your Passwords
by Joe Kissel. Passwords have become a truly maddening aspect of
modern life, but with this ebook, you can discover how the experts
handle all manner of password situations, including multi-factor au-
thentication that can protect you even if a company’s password file is
stolen and hacked.

The book explains what makes a password
secure and helps you create a strategy that in-
cludes using a password manager, working with
oddball security questions like “what is your pet’s
favourite movie?”, and making sure your pass-
words are always available when needed.

Get help choosing a password manager (or
switch to a better one) in a chapter that discusses
desirable features and describes a dozen differ-
ent apps, with a focus on those that work in OS X,
iOS, Windows, and Android. The ebook also
looks at how you can audit your passwords to
keep them in tip-top shape, use two-step verifica-
tion and two-factor authentication, and deal with
situations where a password manager can’t help.

The book closes with an appendix on helping a relative set up a
reasonable password strategy for those whose relatives have dis-
tressing password strategies, and an extended explanation of pass-
word entropy for those who want to consider the math behind
passwords.

This 149 page ebook helps you overcome frustrations that arise
when attempting to design a strategy for dealing with the following
password problems:
 9-character passwords with upper- and lowercase letters, digits,
and punctuation are not strong enough.
 You cannot turn a so-so password into a great one by tacking a
punctuation character and number on the end.
 It is not safe to use the same password everywhere, even if it’s a
great password.
 A password is not immune to automated cracking because there’s
a delay between login attempts.
 Even if you’re an ordinary person without valuable data, your ac-
count may still be hacked, causing you problems.
 You cannot manually devise “random” passwords that will defeat
potential attackers.
 Just because a password doesn’t appear in a dictionary, that does
not necessarily mean that it’s adequate.
 It is not a smart idea to change your passwords every month.
 Truthfully answering security questions like “What is your mother’s
maiden name?” does not keep your data more secure.
 Adding a character to a 10-character password does not make it
10 percent stronger.
 Easy-to-remember passwords like “correct horse battery staple”
will not solve all your password problems.
 All password managers are not pretty much the same.
 Your passwords will not be safest if you never write them down
and keep them only in your head.

This ebook costs $15.00 normally but using the
coupon will make a difference. Overcome password
frustration with some expert advice!! Check this
ebook out and others at www.takecontrolbooks.com.

Submitted by Marcel Dufresne



2016 MacBook Battery Issues Solved
By macOS Sierra 10.12.2 Update

Apple has launched macOS Sierra 10.12.2 update. Of course, the update brings
improved stability, security and compatibility to the Mac; and like all updates – Apple
recommends it for all users. Every operating system update brings improved secu-
rity in response to possible issues with the evolving attacks from malware and prob-
lems that users experience. It can be downloaded from the Mac App Store.

This update also back-handedly addresses the battery life issue that some users
of the new 2016 MacBook Pros have brought up. In what many Mac users are think-
ing of a a sleight-of-hand trick, Apple has simply removed the ‘time remaining’ dis-
play from the battery menu on the top bar with this update, citing that it was
inaccurate. It appears that Apple has done away with the feature because its newer
MacBook Pro series laptops were giving unrealistic battery life expectations, and
were not achieving the company’s claim of 10 hours of battery life. Instead of deal-
ing with the issue, it appears that Apple simply removed the option as a quick fix.

One of the other changes that the new update brings is the addition of close to
100 new emojis. Apple has also redesigned a few existing emojis to give them a
fresher look. MacOS 10.12.2 brings the ability to take screenshots of the Touch Bar
on the latest MacBook Pro laptops that were launched recently, using the Command
+ Shift + 6 shortcut. In addition there are also four new wallpapers to choose from –
Abstract Shapes, Color Burst 1,  2, and 3.

Other changes that the new update brings include:
1. Improves setup and reliability of Auto Unlock.
2. Allows addition of a Chinese Trackpad Handwriting button to the Touch Bar Con-
trol Strip.
3. Adds support for taking screenshots of the Touch Bar using the Grab app or Com-
mand-Shift-6 shortcut.
4. Fixes an issue that caused the Touch Bar emoji picker to appear on the display.
5. Resolves graphics issues on MacBook Pro (Late 2016) computers.

“Fixed”

6. Fixes an issue where System Integrity Protection
was disabled on some MacBook Pro (Late 2016) com-
puters
7. Improves setup and opt-out experience for iCloud
Desktop and Documents.
8. Fixes an issue with the delivery of Optimised Stor-
age alerts.
9. Improves audio quality when using Siri and Face-
Time with Bluetooth headphones.
10. Improves the stability of Photos when creating and
ordering books.
11. Fixes an issue where incoming Mail messages did
not appear when using a Microsoft Exchange account.
12. Fixes an issue that prevented installation of Safari
Extensions downloaded outside the Safari Extensions
Gallery.
13. Adds support for new installations of Windows 8
and Windows 7 using Boot Camp on supported Macs.
14. Fixes an issue that prevented some screen resolu-
tions from being available on third-party displays.
15. Adds support for more digital camera RAW for-
mats.



Prop 'n Go Tote 
From Padded Spaces

There are various accessories that one can purchase for the iPad.
The most essential, I think, is some sort of protection from scratches
and bumps. After that the field is wide open. Since it is quite common
to use the iPad either sitting or lying down, I would list some sort of
stand as a very convenient accessory. The various iPad covers often
have multiple angles that let you adjust the viewing. I find these ade-
quate but, unless I am holding on to the iPad with a free hand, they
do fall over and have to be readjusted. The Prop 'n Go from Padded
Spaces (see my review in the Dec 2011 DoubleClick) allows you to
use the iPad as a hands free device. It is one of my favourite iPad ac-
cessories and I use it practically every day. Padded Spaces now has
a new product out that not only has the prop-up function, but also pro-
vides protection for the iPad in transit. It is called the Prop 'n Go Tote.

The Prop 'n Go Tote is a combo lap desk and messenger bag. The
multi-angle gadget stand will hold up your iDevice at the perfect angle
for whatever work you are doing and also acts as a protective storage
sleeve. It is not restricted to iDevices as it can also be easily used
with heavy books or laptops. It is large enough to hold an iPad (Air,
mini, or Pro), a MacBook (Pro, Air, one), a Kindle, a Surface, a
Galaxy Tab, or books, etc. The iDevice rests on a padded
cushion which makes it comfortable to use sitting on your lap.
It is ideal for home use and this one is designed to take with you on
all your travels.

The Tote resembles a flat cushion with a plastic square on top.
When sitting, the iPad rests securely on the plastic square which has
a hinged centre piece that
permits you to change the
angle of the viewing to 14
different positions. There
are two rubberized strips
running along the sides of
the hinge on the plastic top
that help grip the iPad. The
iPad remains somewhat
secured by these strips so
that it doesn't shift position
if you move your legs or
adjust the Tote's angle.
This item thus allows you
to easily type with two
hands and not have to
worry about the iPad mov-
ing as you type. There is a
one cm front lip which facil-
itates keeping the iPad at
the right angle.

I can't speak for you, but I like to use my
iPad a lot while I am resting, either in bed or
lying down on the couch. The Tote is perfect for
this position. I can prop the iPad up to what-
ever angle I want and not have to keep my
knees bent at the same angle which I would do
without it. It just allows me complete freedom
of movement as I watch TV and use my iPad.
Since it leaves your hands free, there is no
continual holding of the device. My old wrists
and thumbs thank me for the rest. 

For travelling purposes, it comes with a handle and a detachable
shoulder strap. The strap is really long and can be adjusted for use by
anyone, regardless of size. The puffy sleeve form of the Tote is made
for protecting whatever is inside of it. The padded storage compart-
ment fits 15" laptops & tablets. 

It has an extra pocket at the top to hold a phone, wallet, or other
gadgets up to 7" in size. There is a stylus pen (or pencil) holder, so
you do not need to rummage around to locate it. The weather-resis-
tant fabric will keep your devices protected, although it does not com-
pletely close at the top (no zipper or velcro). The specs list the size at
11 x 16 x 2 in (28 x 40 x 5 cm) and the weight as 24 oz (~700 g) with
the belt. I was a bit concerned that the hinged top might flap open as I
walked with it, but this was not the case. It stayed closed.

I have found the Tote to be extremely versatile. I keep coming up
with different uses for it. It worked well supporting my eBook reader.
Again, these are very light weight to start with and are not meant to
require much effort to hold. I just found that it is very nice to use the
eReader as a hands free device. Plus I could prop it at whatever
angle I wanted and quickly change it if I wanted to. It was just more



convenient. If you prefer real books instead of ebooks,
then you will appreciate using the Tote for those heavy
texts. It held any book I positioned on it in place while I
was reading lying down. I had to use one hand to keep
the page from turning but this took a lot less effort than
supporting the book with both hands.

I am sure that I will find other uses for the Prop 'n Go
Tote now that I have it. It was not at the top of my list of
iPad accessories but as you can see from this review it
has a lot more going for it. You can find out more about
it by going to paddedspaces.com/propngo-tote. Watch
some videos there and see how others are using it. The
Prop 'n Go Tote, which this review was based on, sells
for around $60 CND at Amazon.ca. I will be putting my
headphones, battery pack, GPS tracker, and a lot more
into this messenger bag when we take our next trip. It
will serve the dual purpose of holding (protecting) my
gadgets and being a comfortable way to look at my
iPad. It has all the functions of the original Prop 'n Go
plus it is made for travel.

Submitted by Marcel Dufresne

Unexpected Response to iPhones
The Extinction of UFOs

In a unexpected response to the proliferation of Apple technology,
little green aliens and other extra-terrestrials of all colours have been
added to the list of threatened species.  Before everyone toted
around an iPhone there were UFO sightings reported from all over
the world but it was only the fortunate few who just happened to have
a camera out and were poised to take advantage of UFO antics when
they appeared out of the blue to buzz cows and mark cornfields with
crop circles.  One might expect that if the percentage of the popula-
tion toting high-resolution cameras increased by a factor of several
thousand the number of recorded UFO sightings would increase by
the same amount and every sighting would result in multiple confir-
mations from dozens to even hundreds of independent sources -- but
the exact opposite has happened. Since the proliferation of the
iPhone, extraterrestrial life forms of every shape and colour have
been giving planet Earth a wide berth. The number of recorded UFO
sightings has dropped to an all-time low. The number of witnessed re-
ligious miracles has also coincidentally declined to almost zero. This
is a side-effect that has surprised everyone and the scientific commu-
nity is at a loss to explain the sudden disappearance of alien visitors
to our fair planet.



CRTC Ruling Prompts Teksavvy 
To Cut Prices,   

As a long time Teksavvy customer it was nice to get an early Christ-
mas present from Teksavvy and the CRTC. We were notified that the
cost of our internet access will be going down by about $10.00 per
month in January, 2017. We are not celebrating alone.

Hundreds of thousands Canadians got an unexpected letter from
their internet service provider this week containing a promise to lower
their bills starting next year, without any corresponding decrease in
their service. Ontario-based ISP Teksavvy told all of its customers this
week that they can expect lower monthly bills starting right after
Christmas , because of a recent CRTC ruling.

In October, Telecom ruled that incumbent providers (i.e. Bell and
Rogers) were over-charging third-party ISPs like Teksavvy too much
to access the so-called "last mile" of their networks, from the street to
home connections.  An earlier 2010 ruling had mandated that the big
companies charge no more than their own costs plus a 10 per
cent markup, but , as comes to no surprise to anyone who under-
stands the business model Bell and Rogers operate under, the Octo-
ber decision found they were charging far more than that — and
ordered them to stop doing so, at least on an interim basis.

"Correcting wholesale network access rates to a fairer level lets us
create more savings for our customers, get back to innovating on
service and features, and — we hope — spur a more competitive
telecom market in Canada," Teksavvy said in its letter to customers.
"We believe that that's very positive for consumers." Exactly how
much bills will be reduced depends on the area and level of service,
but almost all Teksavvy customers have been advised they will be
saving some money every month starting in January. Some have also
been advised they can expect an upgrade in their download or upload
speeds, too, and possibly even an increase to their data caps.

There is a small catch, however. Because the CRTC ruling was only
interim, it could theoretically be taken away if the regulator doesn't im-
plement a long-term solution. That is why the company is encouraging
its customers to contact the CRTC and let it know they like the new
rules.

"Competitors that provide retail internet services to
Canadians using wholesale high-speed services must
have access to these services at just and reasonable
prices," CRTC chair Jean-Pierre Blais said. "The fact
that these large companies did not respect accepted
costing principles and methodologies is very 
disturbing."



Keep Your Wi-Fi Yours Alone
Create a Guest Account

If you check your Wi-Fi menu at the top of your screen you will find that
there are probably a bunch of possible networks for you to connect to. You
will also notice that they are all locked and require a password in order to get
access. There is a reason for that.

You may not feel comfortable giving out your password and full access to
your internet to every Tom, Dick and Harry that comes to the house. If you
have teenagers you may especially not want your children's friends to have
full unlimited access to your home internet account. Kids download the
damnedest things and are no respecters of copy write or decorum when they
have unlimited access to stuff that you may not want coming into your home
and leaving cookies on your computer or a record with your ISP of dubious
or protected content.  The way to ensure that you do not lose control of your
internet access is through secure passwords and through Guest Accounts.

In order to have a guest account, you must have a router or modem that
supports this feature. Not all do but if you Google “Setting up a Guest Ac-
count on __________” and fill in the blank with the make and model number
of your router you will quickly find the relevant page if
there is one. You will be presented with a link to a page
like the one shown here at right. You may need to dig out
the information booklet that came with your modem or
router but if you can’t find it, the default information for
logging into a device that has not been personalised is
often “admin”  with no capital letters for both the login
name and the password, so give that a try.

When you log in you will be taken to a “Status” page
similar to but not identical to the one shown here at right:
the appearance will vary but all of the feature tabs will be
there, including, if you look carefully, and if this feature is
available, a tab for “Guest Network”. 

Here’s another thought if you are concerned
about the security of your wireless network: All Wi-Fi
routers usually have a set of four RJ-45 ports on the
back where you can plug in Ethernet cables so that
if all of your devices are going to be used in the
same room and within easy reach of the router they
can be simply cabled in but many of the better
routers Wi-Fi routers can be switched so that this is
the ONLY way they can be used. Check the back of
your router to see if there is a little button “Wireless
On/Off”. With this button you can simply turn off
your wireless network temporarily and continue to
used the wired connections, thus effectively shutting
out everything except the devices wired to it.



Clicking on the “Guest Network” tab from
the previous window will open up a page
similar to what you see here: the Guest Net-
work Wireless Settings. Again. your page
will resemble this but may be laid out differ-
ently. Since our router has two channels, 2.4
GHz and 5 GHz I can create two guest net-
works if I want to. 

The Guest Network must be given a net-
work name (also known as the SSID) that is
different from the home account, and if you
want to restrict and control who can access
it, its own wireless security password. You
certainly do not want to leave this network
open or everyone within range will be leech-
ing onto your internet account. But there is
more to it than that. By checking or un-
checkng the little blue box the guest network
can be instantly turned off and on manually.

The other feature that makes a guest ac-
count controllable is that it can be set (see
picture) to operate to a pre-determined
schedule. The guest access feature in your
router can be left on all of the time or it can
be set to come on only on specified days
and only at a specified time and allowed to
operate for a certain limited amount of time.
Once all of these options are set to suit the
way you want your guest network to oper-
ate, look for the Save button, usually at the
bottom of the page. Once the changes are
saved the router will open a dialog window
just to say that it must be rebooted to make
them effective. Click on Reboot and the
router will shut down and go through its nor-
mal startup routine applying the changes as
it goes.

All of these features are designed to make the guest network something you
can control with a degree of confidence that you are not going to find your internet
access being abused. The password to access the guest account can be changed
in a few seconds and if you forget the password it is a simple operation to open up
the window again to check it or change the password or even alter the name of the
guest network if you desire. Its a good idea to bookmark the login page for your
router if you suspect you will or might be coming back to access this feature. It
should take less than a minute to enable this security feature and will take away
the worry you might experience when visitors ask you how to access your wireless
internet. And don’t forget to turn it off after your company leaves.

Michael Shaw 

Off / On button

Off / On button

Off / On timer

Off / On timer



FoldingText - a Suped-Up Text Editor
From Hog Bay Software 

FoldingText is a unique type of text editor. It appears to work like
the others. As you type, the words are shown on the page. But it has
a considerable number of extra functions that makes some of the
more difficult tasks so much easier. Creating a link or adding a list to
your text is done through typing rather than searching for the right key
codes from the drop down menus. Read on to understand how it can
make you so much more productive in your work.

FoldingText uses something called Markdown formatting to give
structure to your text files. Markdown is a conversion tool for web
writers. It enables you to write using an easy-to-read, easy-to-write
plain text format. It then converts it to a structurally valid format. The
idea is that a Markdown-formatted document should be publishable
as-is, as plain text, without looking like it's been marked up with tags
or formatting instructions. Here are some examples of how you can
quickly format your document:
- To create a heading, type "#" followed by a space.
- To create a list item, type "-" followed by a space.
- To create a numbered list item, type "1." followed by a space.
- To format text _italic_, surround with _s (single underlines).
- To format text **bold**, surround with **s (double asterisks).
- To create a [link](http://www.foldingtext.com) surround the link text
with []s immediately followed by the target URL surrounded with ()s.

FoldingText hides the extra syntax characters after you type them
in. For example the **s used to make text bold are hidden. The char-
acters reappear when you click the cursor in that word for editing. I
like it because it makes my document easier to read. FoldingText al-
lows you to 'copy' your document text as HTML or RTF. Go to the
menu item Edit > Copy for this option. The implemen-
tation runs the selected text through a standard Mark-
down converter and puts that result on the clipboard.

By default, FoldingText files use the '.ft' extension.
The reason that it does this is because FoldingText
documents may contain some additional formatting
not found with regular text editors. However, it is im-
portant to recall that all FoldingText files are just plain
text. You can open any of them in any text editor. And
you can open any plain text file in FoldingText no mat-
ter what the file extension is. That being said, when I
just wanted to transfer a FoldingText document to my
old TextEdit application, I had to copy the text rather
than just dropping the file into TextEdit. If I tried to
drop it in, I got all the extra hidden formatting showing
up. Copying is not perfect either as a lot of that extra
formatting is lost. The web link made in the Folding-
Text document does not copy through. 

Lastly, printing or printing to PDF produces a document that is
identical in formatting to that in FoldingText (WYSIWYG).

FoldingText hides the extra syntax characters after you type them
in. For example, the **s used to make text bold are hidden. The char-
acters reappear when you click the cursor in that word for editing. I
like it because it makes my document easier to read.

And now for some productivity tips. In my reviews, I like to put in
headers for each of the chapters I write and then delete these after.
This is the way I organize my thoughts. FoldingText not only has this
feature built-in, it allows me to hide each of these sections so that I
can focus on only one at a time. If you click on a heading's leading '#',
the heading will fold out of the way leaving you with the rest of the
document to play with. I can see me using this to hide the completed
part of my work, highlighting what I have left to do. Folds only affect
your document's presentation, they don't change what is saved.

I sometimes get too verbose with my writing. FoldingText has a
built-in word count (which can be turned off if you wish). Without los-
ing any concentration, I can see how much I have done or need to yet
do.

FoldingText also supports multiple cursors. I have not previously
seen this before and as such I am not too sure how I would use it.
Just like many other functions of FoldingText, it is something that you
could play around with. By holding down the Command key and click-
ing your mouse you add a new cursor. It might be useful if you want
to edit multiple lines of text in the same way.

In this next section, I would like to highlight some untext-like func-
tions that FoldingText has built-in. The developer labels these as



modes. There is a calculator mode, which also in-
cludes conversions. This is simply called up by typing
in "# .Calc". Another mode in FoldingText is as a
ToDo list. It will create a ToDo list, with checkboxes
and the ability to put a check in the box when it is
done. Just this function by itself is a great incentive to
buy FoldingText. You can create a ToDo list file to
handle this task without actually doing any text edit-
ing. I created a special timer file using two other
modes, schedule and stopwatch. I run this file sepa-
rately from the text editor. I have it notify me to take a
break for every 30 minutes of work so that I am not
sitting the whole morning. I am sure that you get en-
grossed in your work, as I do, and forget that time is
passing. The scheduler beeps a notification each half hour. You can set
it to whatever time you want. The stopwatch part keeps track of the
total time I have spent on the project. It can be turned on and off and
resumed if the project takes more than one day. This is another fantas-
tic productivity function found in FoldingText. I can't show these functions at work
in my TextEdit document. Have a look at the images I provided with the review to
see these various modes in action.

Modes are an extension mechanism for FoldingText. To see and learn how to
use the modes installed in your version of FoldingText, you can look in the Help
menu for the mode-specific User's Guides. There is likewise a video showing it in
action. Extra functions can also be added in as plug-ins. These are accessed
through Edit > Run Command. I went to the FoldingText web site and added in
some date/time functions. Now I can add the exact date and time anywhere I
want in the document. How to do this, as well as installing other plug-ins, is very
well explained at the HogBay Software support web site, which can be found at 
http://support.hogbaysoftware.com/t/foldingtext-extensions-wiki/121.

Reading about this application is fine but of course, the best approach is to try
it yourself. 

You can download a trial copy of it from the internet at www.foldingtext.com.
You can purchase the full application from the Apple App Store for $39.99. Re-
member, it is much more than a text editor. With the ToDo list, as well as a timer,
there are numerous uses for it. And of course I did this complete review using the
application. The more I use it, the more comfortable I will be with it, and the better
use I will put it to. Help improve your productivity and try out this application. 

Submitted by Marcel Dufresne



I Saw This.…
There is a running joke on Reddit about the

type of people who see something neat on the
internet and within a very short period of time are
going around showing it off and saying “I made
this…”. 

Well, here is a “thing” I saw on Redditt and I
like to pass it on. To do this “thing” you will need
a computer, a laser-writer printer, clear packag-
ing tape, a bowl, and access to water, and a pair
of scissors. If you have a Mac you already have
enough fonts and access to enough black and
white clip art to do a myriad of crafty things like
this thing. To do this thing, TextEdit or any other
desktop publishing program on your Mac is suffi-
cient.  

1  Create a document and print it, the content
being whatever you would like to see on a label
or series of labels. Use whatever font at what-
ever size you would like to see on a label. Big
and bold is good.

2  Cover the printed words carefully with clear
packaging tape, the wide stuff.

3  Use a spoon to lightly run over the tape in
order to chase out any air pockets.

4  Cut the plastic-tape covered labels apart.

5  Put them into water and let soak for about
15 minutes.

6  Rub the paper off the back of the tape. It
should come off easily once it gets started.
When wet, the tape may appear cloudy and not
at all sticky.

7  Set the labels aside to dry. The stickiness
will return as the tape dries.

8  When the labels are dry, stick them onto
anything. The label is basically just a piece of
tape with printing on it. 

Decorate anything with your home-made la-
bels. Anything tape will stick to: Car, bike, com-
puter, mugs, glassware, whatever.

1
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65

4

3

2



The Warlock of Firetop Mountain 
from Tin Man Games

The Warlock of Firetop Mountain is a fighting
fantasy adventure reminiscent of the Dungeons
and Dragons game of old. It is a digital tabletop
RPG with miniature figures and multiple character
paths to follow. It is a fantasy story told through
thousands of choices, all of which are remem-
bered and make every adventure unique. Playing
this type of game also reminds me of the original
text adventure games where one had to write each
and every move that we wanted our character to
make. Move right, go left, get this, take that. The
game play back then was all in our imagination. I
had to get out some graph paper and keep track of
my movement so that I was not retracing my steps. With the graphics
here, one feels much more a part of the adventure. Your avatar hops
along the path from one room and corridor to the next, each hidden
from view until you decide to step in.

The first choice in the game, once you start it up, is to determine
which of four characters to play. Each of these has their own special
qualities in terms of skill, luck and stamina. Your skill reflects your
swordsmanship and fighting expertise. Your stamina reflects your
health. Your luck indicates how naturally lucky a person you are. Your
task is simple. Get to the top of the mountain with the eye of Zargon
that you pick up along the way.

You start at the bottom of the mountain and make your circuitous
way up and through various passageways within to the top. The
game is predominantly text-based, using a nice-looking parchment
design that appends the previous segment to a running thread of
paragraphs as you make new decisions. As an example, you could
find this message: "After a few yards you arrived at a junction." Now
you must choose either Turn West of Turn East. The approach is
darkened so that you no idea what lies ahead. The maze like nature
of the paths make for very intriguing travel. Should you go east or
west? Should you enter a room and explore or not? Treasures might
be discovered within, but many must be fought for. Searching a de-
feated foe could produce a potion of invisibility or a poisonous dart.

Playing one character each time will produce the same prizes in
the same location, as well as the same creatures to fight. The great-
est randomness to the game comes in the battles. Each battle scene
is unique as all movements of the opponents are completely haphaz-
ard. I tried playing the same battle a second time, anticipating their
first move in order to get in a good first shot, but they moved differ-
ently and I was defeated quite quickly. The battles play out on a tiled
grid. You and your opponents can move up, down or sideways, but
not diagonally. If you move, you cannot attack. 

Attacks can be made in all directions, including diagonally. A good
tactic is to attack a location that you expect the opponent to move to,
that way you are hitting and not being hit. This works if you guess
right. Remember, their avatars are using the same random logic as
you are. The hardest battles are against three or more opponents at
the same time. Each of them can attack you, but you can only go
after one of them at a time. Fortunately you do inflict more damage
with each hit than they do. Your stamina points reflect your health.
Once this drops to zero, you are dead. Your choice of avatar provides
you with some fancy attacks. Each avatar has their individual skill set.
Some can slash sideways. Some can attack two or more squares in
one direction. The problem here is that there is a recovery time
needed to restore that special hit technique before you can use it
again. Lost stamina can be replenished at specific rest spots along
the trail. However, these are few and often far between. Your skill
value comes into play when both you and your opponent decide to at-
tack at the same time. Dice are thrown and their total is added to your
skill value. The sum is subsequently compared to that of your oppo-
nent with the higher total inflicting the damage.

The game saves itself and can be resumed from exactly where
you left off. As dying along the way has a high probability of occurring,
you are given three resurrections per game played. You will resurrect
at the last rest station, and hopefully you will have learnt some valu-
able lessons that will tilt the same encounter in your favour. The luck
portion of the game is quite unique. It again goes back to the dice
throwing of the D&D games. Supposing you are to cross a decrepit
looking bridge. You toss the dice to determine your fate. As long as
the dice throw is lower than the value of your luck, you survive. If not,
then you will lose luck points which will make winning the next luck
bump even harder. Trying to throw a 3 or less on two dice in order to
continue on is pretty near impossible. Again, the game allows for a re-
plenishing of luck points at certain spots.



I would like to see two levels of game play. One would be just as it
is. The other, easier mode of play, would have more rest stops along
the way, allowing you to replenish your stamina more often. I could
not count the number of times I died along the path until I finally got to
the top. As each battle requires a different strategy each time it is re-
played, there is no sure fire path to the top. Another anomaly to this
game is the experience points for your avatar. In most RPG games,
this increases with each successful battle. This is not so with Firetop
Mountain. What you start with is the best you will have. Even when
you replenish stamina, you can't end up with more than what you
started with. I am not sure I like this aspect of the game. It certainly
makes getting to the very top extremely hard. If you find that the
death of your avatar is becoming a too common event, you can play
the game in the 'Free Read Mode'. The paths and all the treasures
along the way are the same, but you can opt out of fighting. Each bat-
tle can be by-passed with you declared the winner. That way you can
get a feel for some degree of success.

This game is available on Steam for $21.99. With Steam you get
the added quest of trying to obtain as many achievements as possi-
ble out of the 50+ listed. I always find this a terrific incentive to replay
games over and over again. You can find out more about this game
from the game web site, fightingfantasyapps.com. Bring the old D&D
to life with this difficult but realistic RPG. You won't have to rely on
your imagination as the rooms spring to life on the screen.

Submitted by Marcel Dufresne



AKVIS 
MultiBrush 9.0

AKVIS MultiBrush is a new enhanced version of AKVIS Stamp.
The registered users of Stamp can activate MultiBrush for free. You
will recognize the old Stamp features in the Chameleon Brush. Fea-
turing a collection of healing and enhancement brushes, cloning and
stamping tools, AKVIS MultiBrush helps artists, photographers and
home users to perform portrait enhancement, retouch image flows
and remove unwanted objects from digital pictures.

AKVIS MultiBrush, the second program in the AKVIS Restoration
bundle, is a digital image touch-up program with a couple of powerful
repair tools that can be used to fix up portraits that have somehow
not turned out as expected. It can be purchased sepa-
rately or with the other two AKVIS programs in this issue
with a 40% discount as part of the AKVIS Restoration
Bundle. Although the three programs function in a simi-
lar manner, each of them has unique features that make
them a natural choice for photographers who may need
to clean up or restore images. 

AKVIS MultiBrush makes it easy to retouch photos
and enhance portraits in Windows and Mac. Featuring a
collection of healing and enhancement brushes, cloning
and stamping tools, AKVIS MultiBrush helps artists,
photographers and home users to perform portrait en-
hancement, retouch image flaws and remove unwanted
objects from digital pictures. Available as a stand-alone
product or a plug-in for Adobe Photoshop, AKVIS Multi-
Brush removes wrinkles, scars, scratches, and en-
hances imperfect skin on portraits in the most natural
way. Spots, stains, and dust are easy to mask and re-
move.

The Chameleon Brush heals skin problems and re-
moves dust, spots and scratches without affecting back-
ground texture, lighting or colors. This unique brush is
similar to Adobe Healing Brush, yet offers more flexibility
and customization options.

AKVIS MultiBrush is indispensable when you need to revive old
black and white photos. Using a set of brushes, especially
Chameleon Brush and Clone Stamp, you can restore many old, dam-
aged scanned images. The program can remove dust, scratches, and
spots from the surface of an image. Your family photo album will have
a second life. The Artistic Cloning mode of the Chameleon Brush tool
makes AKVIS MultiBrush truly unique. This innovative mode makes it
possible to clone parts of a picture in a really smart way. Sample, ad-
just and re-source parts you’re about to multiply through the image,
and create impressive collages with little effort. The ordinary Clone
Stamp tool enriched with the innovative features of rotation and scal-
ing of the cloned area, lets you achieve impressive results.

The uses and limitations of each type of license are outlined on
Page 3 of this issue, in the article about AKVIS Retoucher. Everything
about licensing AKVIS Retoucher also applies to AKVIS MultiBrush
and to AKVIS Neon and AKVIS Coloriage, found elsewhere in this
issue.

Licensing options and prices are as follows:
 Home - PlugIn ($ US 49) 
 Home - Standalone ($ US 49)
 Home Deluxe - PlugIn+Standalone ($ US 65)
 Business - PlugIn+Standalone ($ US 89)

See more of Irma’s pictures on the next few pages.



AKVIS MultiBrush has many
tools that one can use to re-
touch photos, or to remove un-
wanted objects in photos and
improve portraits. I used the
Chameleon Multibrush tool to to
remove large eyeglasses from
the picture at left, following a tu-
torial that AKVIS had on their
website, where they offer clear
and informative steps on how to
do it quickly and easily. 



I used Multibrush to re-
move the “Shiny Face”
problem in a few pictures
and have included a sam-
ple below.

In both examples, after
using the Chameleon
brush, I also used the
Clone stamp tool to make
slight adjustments to the
photos.



The “Targeted SCAM” SPAM
Putting together the January issues of past years has always been

problematic. Because there is no MaUsE meeting in the immediate
December to draw on, the January issues tend to be bit thin. I cannot
rely on December to provide colourful meeting and raffle pictures the
way I can with most other issues. And I can’t rely on the membership
to make the effort to submit articles because they (being you) simply
don’t. With that in mind, I include a little piece about targeted SPAM.
Unlike SPAM that goes out to thousands of users whose email ad-
dresses are gleaned from hacked email accounts, targeted SPAM
goes out to a select few recipients, usually one at a time.

One example of targeted SPAM: About 15 years ago I sold a car
on the internet. It was an an unusual car, being a “kit car” that I had
made from a cannibalized 1978 Ford Mustang. The “kit” was an entire
frame, floor pan, nine red fiberglass body panels, carpets, seats, inte-
rior trim and chromed accessory package that made it look like a
1952 Jaguar XK120. The Mustang provided front suspension, rear
axle & springs, complete drive train and electrical harness, and pedal
assembly. It took several years to build. Incredible as it now seems,
we built up the body and did all of the fit and finish in the front living
room of the house (now our computer room) and then disassembled
it and took it out to the garage to put it onto the frame & floor. Then
we tore up the carpets in the front room and re-did the floor. I kept the
car for summer driving but eventually offered it for sale on the internet
for $9,000 and became the recipient of targeted SPAM.

. Basically, I received an email from someone who claimed that he
wanted to buy the car. He responded via email and asked for an ad-
dress to come to see it. He then responded again by email and said
that he was unable to come right away to see the car, but would be in
touch. I then received a letter (!) from him with a beautifully embossed
and certified cheque drawn on an account at a Regions Bank in

Georgia for the full asking price of the vehicle plus an extra
$2,000.00 with instructions to deposit the certified cheque in my bank
account and send the extra $2,000.00 to the ‘shipper” who would
then come to pick up the car. The $2,000.00 was to be made via a
Western Union Money Order which I was supposed to buy and send
to a party in AFRICA who would arrange the pick up.

The cheque was a thing of beauty, likely made on a Macintosh, and
would have been accepted at my bank if I had deposited it (I didn’t)
but it was bogus. The intention of the whole procedure was to induce
me to deposit the $11,000 bogus cheque and then rush out to pur-
chase and send a genuine Western Union Money Order to Nigeria. I
still have the cheque. End of story. 

Now I am clearing out some vintage computers by posting stuff on
Craigslist and received an email with this message: 

So the targeted SPAM in this scam involves finding actual sellers
on buy and sell sites like Craigslist or Kijiji and then asking the sellers
to supply the Buyer with an email address where PayPal payment
can be sent. If I agreed, (I didn’t) I would shortly have received an offi-
cial-looking email supposedly from PayPal indicating that I have been
paid a sum of money via eTransfer of some sort that will appear in my
account within a few minutes, as soon as I accept….  So…. I should
just go ahead and complete the transaction by performing an action
that requires me to CLICK HERE NOW to log into my PayPal to ac-
cept to receive the payment. 

So the purpose of this whole rigmarole is to induce me to give out
my PayPal address to a stranger so he or she can send me a bogus
message that will induce me to go to a phony log-in web page and
give up my PayPal information so the scammer can quickly use the
information in order to impersonate me in order to either spend the
money in my account or transfer money from my account. Aint going
to happen.…

Michael Shaw



Coming Soon...
Changes to Dropbox

Dropbox will soon be ending support for the Public
folder. Dropbox Basic users will be able to use the
Public folder until March 15, 2017. After that date the
files in users’ Public folders will become private, and
links to these files will be deactivated. The files will re-
main safe in Dropbox. If you are a Dropbox user and

you’d like to keep sharing files in your Public folder, you can create
new shared links. Just make sure to send the new URLs to your col-
laborators.

There will be two ways to give other people view-only access to files
in your Dropbox: share a file or create a shared link.
1   Share a file if you only want certain people to have access to
your file. Note: People you share a file with must have a Dropbox ac-
count. If you share a file to an email address not associated with a
Dropbox account, then the person can create an account or use an
existing account that's under a different email.
2   Create a shared link if you want anyone to be able to click a link
to access your file—people don't need a Dropbox account to view
your file.

Regardless of which you use, people can still:
 view files
 comment on files
 download a copy of files

But, people can't edit the original files in your Dropbox.

Any change in the way Dropbox operates is big news. Dropbox
has over 500 million users worldwide and over 1.2 billion files are up-
loaded to Dropbox every day. With 35 billion Microsoft Office files
stored on Dropbox servers, and about 4,000 file edits every second,
Dropbox is hugely popular with anyone who needs a secure place to
park pictures and files where other people can view them. If you use
Dropbox, mark March 15, 2017 on your calendar and be prepared.

To share a file:
If you haven't already, install the Dropbox desktop app
on your computer.
Press the Control key on your keyboard and click the file
at the same time (or right-click the file).
Select > Share…
Choose > Can view.
Enter the name or email address of the people who need
access to your files.
Click > Invite.

To share a link
If you haven't already, install the Dropbox desktop app
on your computer.
Press the Control key on your keyboard and click the file
at the same time (or right-click the file).
Select > Copy Dropbox Link.
The link will be copied to your clipboard. You can then
paste it to an email, message, or wherever people can
access it.

OS X Yosemite: Open folders 
in new Finder windows

One of the things that bothers me about Yosemite is how difficult
it is to move items among nested folders. When you open a folder in
the Finder, by default the folder’s contents usually replace the cur-
rent contents of the window. If you prefer, you can open a folder in a
new window. In order to set folders to open in new windows, do this: 
 In the Finder, choose Finder > Preferences, then click General.

Select or de-select “Open folders in tabs instead of new windows.”

 Press the Command (⌘) key while you double-click the
folder. The folder opens in a new tab or window, depending on
your Finder preferences.

Tip:   If the Finder toolbar and sidebar are hidden, double-clicking
a folder without pressing the Command key opens the folder in a
new window.  To open a new Finder window without opening a spe-
cific folder, choose File > New Finder Window or press Command
(⌘)–N.



AKVIS 
Coloriage 10.5

This is the third program in the AKVIS Restoration bundle and the
most expensive. Possibly for many amateur photographers and peo-
ple who like to play with digital image files, this might be the most
useful of the three. There are three licensing options for Coloriage.
The limitations for the different types of licenses are found in the
AKVIS Retoucher article on Page 3 of this issue. The Home PlugIn or
Standalone version is US $ 75. The Home Deluxe option, including
both the PlugIn and Standalone is US$ 90. For commercial use the li-
cense for Business PlugIn plus Standalone is US $ 199.  But, of
course, the program can be downloaded and used for 10 days as a
fully featured demo so if you think this is a program you could use
regularly, its probably a good idea to check out the online tutorials  on
the website (www.akvis.com) and set aside a few images to work with
before you download and install the program. Coloriage is compara-
tively easy to use, once you understand the basics of the program.
The trial download includes the option of a PDF manual that is very
helpful in getting you started.

With AKVIS Coloriage the user can easily and quickly match and
manipulate the colors of an image: from colorizing old black and white
photos from your scanned images from the old family albums to re-
placing colors in your color photos. This all sounds very easy and you
may say that you can do all of that with Adobe Photoshop but AKVIS
Coloriage is designed to be easier and faster and achieve better re-
sults in less time. If it didn’t, there would not be a need for it.

AKVIS Coloriage is helpful if you need to:
 add color to black and white photos;
 add color to sketch drawings (book illustrations, manga and

comics art);
  replace colors on a color photo;
  try different color schemes for interior and exterior design;
 perform selective de-saturation or colorization of areas on a

photo.

On the next few pages are a few illustrations of monochrome
(black and white) pictures that Irma played with using Coloriage. The
three pictures have each been treated with a different process. 

The goddess with the dancing figures has been carefully cut into
many little zones of colour and then rendered so that each discreet
object has a different colour than the background. 

The picture of the pickup truck and gas station was rendered in less
than 5 seconds with two broad strokes that bled uniformly across the
image to give it a sepia tone. 

The door has three broad zones of exclusive colour that colour and
separate the wooden object from the surrounding stone textures.









The big news from Yahoo just before Christ-
mas was that Yahoo has discovered a 3-year-
old security breach that enabled a hacker to
compromise more than 1 billion user accounts,
breaking the company’s own humiliating record
for the biggest security breach in history. The
digital heist occurred in August 2013, more
than a year before a separate hack that Yahoo

announced nearly three months ago . That breach affected at least
500 million users, which had been the most far-reaching hack until
the latest revelation. Both lapses occurred during the reign of Yahoo
CEO Marissa Mayer, a once-lauded leader who found herself unable
to turn around the company in the four years since her arrival. Earlier
this year, Yahoo agreed to sell its digital operations to Verizon Com-
munications for $4.8 billion – a deal that may now be imperiled by the
hacking revelations. 

Yahoo didn’t say if it believes the same
hacker might have pulled off two separate
attacks. The Sunnyvale, California, com-
pany blamed the late 2014 attack on a
hacker affiliated with an unidentified for-
eign government, but said it hasn’t been
able to identify the source behind the 2013 intrusion.

In both attacks, the stolen information included names,
email addresses, phone numbers, birthdates and security
questions and answers. The company says it believes
bank-account information and payment-card data were
not affected.

Yahoo has sent out notices to its users
suggesting that they change their Yahoo
passwords if they have not been changed

recently but changing Yahoo passwords will be just
the start for many users. They will also have to comb
through other services to make sure passwords used
on those sites are not too similar to what they were using on Yahoo.
And if they were not doing so already, they will have to treat every-
thing they receive online, such as email, with an abundance of suspi-
cion, in case hackers are trying to trick them out of even more
information.

Yahoo recommended that all of its customers use Yahoo Account
Key, ( https://help.yahoo.com/kb/SLN25781.html ) an authentication
tool that verifies a user’s identity using a mobile phone and eliminates
the need to use a password on Yahoo altogether.



Computer Security 1:
Disable Automatic Login

When you set up your Mac for the first time, you
create an administrator account that automatically
logs in when you turn on your computer - a conven-
ient feature that poses a major security risk if you
regularly use your Mac in public, or if other people
use your computer. For maximum security, you’ll
want to disable automatic login, even if you’re the
only person who uses your Mac.

 1 From the Apple menu, select System Prefer-
ences.
 2 Select Security & Privacy.
 3 Click the General tab.
 4 Click the lock and authenticate with an ad-
ministrator account. The window shown below ap-
pears.
 5 Select the Disable automatic login checkbox.

Note: Automatic login is automatically disabled if Fil-
eVault is enabled. The only difference is that com-
puters protected by FileVault require users to log in
immediately after the computer is turned on.

 6 Click Show All.
 7 Select Users & Groups.
 8 From the sidebar, select Login Options. The
window shown below appears.
 9 Select Off from the Automatic login pop-up
menu. This forces users to log in before using your
Mac.
 10 Optional: Select Name and password to re-
quire users to enter both their username and pass-
word. This deters criminals by making them guess
both the username and the password, but means
that users have to do a little more work.

The next time you turn on your Mac, you’ll be
prompted to log in with your username and pass-
word. It’s not as convenient as leaving automatic
login enabled, but it’s a heck of a lot more secure.

Select Login Options
to edit the settings

shown here.

Select this check box to disable 
automatic login for all user accounts

Turn Automatic Login off. This requires
Users to login to use the computer.



Computer Security 2:
Setting Up a Guest User Account

I don’t know about you but it bothers me when other
people touch my computer(s). Years ago, when Macs
were the exception rather than the rule, we had company
over and one of the adults asked me if her child could
“play” on our computer. I thought not. Since then there
have been a few occasions, before smart phones be-
came popular, when people visiting have assumed that it
was just a formality to ask if they could use my computer
to check their email (it wasn’t) and I once vividly recall
walking into a scene years ago in which a friend of one
of our daughters was angrily banging away on myG4
MacBook in a sulk with a tall glass of red wine sitting in
front of the keyboard. 

Apple computers are designed to be used in a multi-
tude of ways and every Mac is used differently. But
EVERY Mac should start up with a list of users and a re-
quest for the password in order to access the Desktop. If
yours doesn’t, see the instructions on the previous page
to make it happen. If you want to set your computer up in
such a way that other people can temporarily have con-
trolled access to your computer without having access to
your files, you need to set up a Guest
account. You do that in the Users and
Groups pane in System Preferences
under the Apple menu. There you will
see a little discrete plus and minus sign
under the Login Options where you can
create a guest account. Logging in as
Guest does not require a password. If FileVault is turned
on your Guest can only access one application, Safari,
and when the Guest logs off your computer all of the in-
formation and files in the guest account will be automati-
cally deleted.  

Depending on to whom you will be lending access to
your Mac it may be a good idea to enable and set up the
Parental Controls pane. As we all know, there is a lot of
weird stuff that can be seen (and obscene) on the inter-
net that is not suitable for young viewers and their
friends. Of course you trust your own children or grand-
children not to download inappropriate material but these
is no sense in tempting fate by ignoring the potential
power of peer pressure and natural curiosity. If all of their
friends are busily downloading pirated videos, music,
software, and movies there may be a false understand-
ing of what is and isn’t acceptable.With Parental controls
you can limit your guests access to harmless activities.

Select Login 
Options and click
the plus sign to 
create a guest 

account.

+



Besides accessing Parental Con-
trols through the Users and Groups
guest account setup, you can find it
among the other System Preferences
under the Apple menu. 

As you can see here at right, the Parental Controls
allow the Administrator (that ‘s you) to have a wide
range of controls over your Guest account including
but not limited to what applications can be accessed
by the guest, what types of websites can be viewed,
what kinds of movies can be streamed, what online
stores can be visited, and when and for how long the
guest can go online. A Guest account configured for
students will only allow access to educational websites
and will actually keep track of how many or how few
hours per day the access will be available and what
time of day or night the guest account will lock out the
Guest on school nights and on the weekend. Most of
us will never need to set up Parental Controls  but all
of this is designed to give peace of mind to those of us
who must. 

Privacy
From the Privacy tab, you can control the applications
and services that are allowed to have access to the in-
formation stored in your child’s user account. This may
be important to parents who want to keep bad people
from obtaining information about their kids. Here, you
get the following settings to configure:
 Managing app privacy settings
Preventing access or changes to location services set-
tings
Preventing access or changes to contacts settings
Preventing access or changes to calendars settings
Preventing access or changes to reminders settings
Preventing access or changes to Twitter settings
Preventing access or changes to Facebook settings
Preventing access or changes to Diagnostics settings

The Other tab lets you configure some other vari-
ous features of OS X that you may or may not want
your child to have access to. With today’s technology,
children have access to almost anything they want to
on computers and the internet and parental controls
are a powerful way to control your child’s experience
on the Mac. Better safe than sorry.

Michael Shaw



AKVIS 
Neon 2.5

It was not my intention to make this issue all about AKVIS but the
company polished off 2016 with a huge release of software updates
and Irma has been busy playing with them. This one is called Neon
and it was updated to version 2.5 about a week before Christmas. 

AKVIS Neon creates sparkling drawings that look like they were
drawn with light or luminescent ink. Like other AKVIS programs, Neon
2.5 is highly entertaining and productive at the same time; it does not
require any special skills to be used effectively. The program can be
downloaded (http://akvis.com/en/download-macintosh-software.php)
from AKVIS and in most respects functions just like any of the other
AKVIS offerings: you get to use Neon 2.5 as either a fully featured
standalone application or as a fully featured Adobe Photoshop-com-
patible plug-in for 10 days to see if you like it before you decide if you
want to spend the money to own a copy. Either package offers nu-
merous presets and decoration effects that let the user generate won-
derful glowing images within seconds. See the next page for a FEW
examples of the more than 50 Presets that come with Neon 2.5 

Licensing options for Neon 2.5 are as follows: 
 Home PlugIn for US $ 39, Home Standalone for US $ 39, 
 Home Deluxe PlugIn plus Standalone for US $ 49, 
 Business PlugIn plus Standalone  for US $ 72.



On this page and the next I have presented small
samples of a dozen of the the 51 Presets that come
with Neon 2.5. The Presets are a great place to start
and a vital part of the program. They function as an
instant introduction to what this program can do.

The thing to remember is that every button and tool
in the Neon program opens up a whole new feature or
expands the ability of the program to create unique
special effects. The program invites exploration and
renders your images within a few seconds.



The Presets are just the starting points with Neon 2.5. Here, below,
are a few more of them displayed. The program functions in two
modes: Express and Advanced. In Express Mode there is an abrevi-
ated set of controls that allow the user to quickly polish off an image
by adjusting a few critical features, like Glow intensity and Blur level.
Changes are instantaneous. In Advanced Mode the user has access

to the same Presets but also four more complex sets of controls for
Effect, Decoration, Image and Adjustment that allow the user a much
wider range of control and variation of background textures, over-
print, and access to extra features and tools. 

Michael Shaw


